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You are going to love Skype Me! From Single User to Small
Enterprise and Beyond. Here’s why.

Michael Gough knows his stuff. Michael has also com-
pleted a remarkably difficult project around a remarkably
cool product, Skype.

Michael is a busy guy. I have no idea where he found
time to write a book. He delivers consulting services to
clients of a Fortune 50 company where he works. He’s been
at it for 18 years. On the side, he is a Computer Security

Consultant, presenting at conferences working with associations and groups
advising agencies such as the FBI. Michael knows Skype. He is the man behind
the hot Web sites www.SkypeTips.com and www.VideoTips.com.These
sites are filled with helpful advice, product reviews, stories, and articles that
make the hundreds of thousands visitors get a richer experience from the
Skype Application.

What’s remarkable about this book? A few months ago Michael first shared
his idea in a message to  me:“I am going to write a book to help home users,
super users, small businesses, and large corporations understand Skype.” I
studied the outline.A few days later I sent a message back to him:“Michael, it
can’t be done.” But I ate crow as I read the completed manuscript.

Michael has covered all that you need to know about Skype. His book will
sweeten your Skype experience. It contains basic information for early adopters
as well as technical tips for power users.
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Foreword
by Bill Campbell



What’s cool about Skype? What makes Skype such a remarkable product?
How can it possibly reach out to touch individuals in such a wide spectrum
from users in the home to a large corporation? The short answer is simplicity.

Skype’s simple, subtle user interface hides a deep layer of rich functionality.
It’s so simple that my mom can use it. In fact,“Can mom use it?” is a question
asked by members of the Skype development team every day. Skype is an appli-
cation that even after over two years of daily use continues to “wow” me. Let
Skype wow you, too.

Let this book help you quickly discover the hidden delights inside the
Skype application.

—Bill Campbell
Technical Editor, Skype Journal

www.SkypeJournal.com

www.syngress.com
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Getting Started
Using Skype

Solutions in this chapter:

■ Signing Up As a User

■ Adding or Searching for Contacts

■ Starting a Chat

■ Making a Test Call

■ Making Your First Call

■ Inviting Others to Join Skype

■ Setting Your Status

■ Advanced Settings
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Signing Up As a User
We covered signing up as a new user during the installation process, but you might want or
need to create multiple users or accounts at a later time. For example, you might want one
account for you and another account for someone else in your household. Maybe you have
a computer and a laptop, so you want to have a different account for each. Whatever your
need, you can create and use multiple accounts in Skype.

After Skype has logged you in, you will be presented with the following screen:

To create an additional account, select the File menu, and then select Log in as a
New User…, as the following image indicates.
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You will then be presented with the same screen you saw when you first signed up for
your Skype account.

Select the New Users – Create a Skype Account tab.As we covered in Chapter 2
when you first signed up, create a new Skype name for yourself and follow the prompts.
Once you are successful in creating a new account, Skype will log on the new user for you.

Switching between Users
If you have more than one user on your system, you will want to switch between these
users from time to time.To switch between users you have created or allow any users who
want to use their Skype accounts on your computer, select the File menu and then select
Log in as a New User…, as the following image indicates.
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You will then be presented with the following screen:

Select the Skype Name drop-down box, and you will see a list of all users who have
logged in to the computer.

Select the user you want to log on, enter the correct password, and select Next.
Do not worry about the Set connection parameters and proxies link just yet.This is an

advanced option that we’ll cover later.
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You will then be presented with the main Skype screen showing the user you selected
is logged in.

Adding or Searching for Contacts
Now that you are up and running, you will want to add Skype users or search for Skype
users with whom you want to communicate.You can verbally ask people you know for
their Skype names, send them an e-mail, or search in the Skype directory for them.You can
add users two ways: via Add a Contact for a known Skype name or by searching the Skype
directory for users.
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Adding Contacts
There are two ways two add contacts. One is to click the icon or choose Add a

Contact from the Tools menu.

Select one of the two options to add a user, and you will be presented the following
screen.

Enter the Skype name that you want to add and press the button.
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You will then be presented with the results of your search to validate the user you want
to add.

If more than one user is listed in the results, select one of them.At this point you may
view the user’s profile or just add the selected contact.You may also double-click the user’s
name and you will be presented with the following screen:

This screen will show you the contact’s short profile so that you can verify that he or
she is the person you want to add.You can click either the Close or, if you want to add the
contact, click the Add Contact button.
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Once you add the contact, you will be presented with the following screen.

You can send the contact a message letting him or her know who you are. I left the
default message on the screen, but you may type anything you like in the message window.

You are then presented two choices for requesting authorization. Every time you ask a
Skype user to add you to their contact list requires the user’s authorization.

The default option that is selected tells the person whom you are asking to add you to
their contact list that you are online.

For more privacy, you can ask a contact to add you but not let them know when you
are online.This is appropriate when you want to make calls to a person but not let them
know every time you are online.

Understanding the Basics… Request Authorization
We recommend leaving the default selection when you request authorization
and let your contact see when you are online, unless you desire more privacy
and do not want to be disturbed.

After you send the request for authorization, you will be returned to the search result
screen. Go ahead and close the window to return to the main Skype screen.

8 Chapter 3 • Getting Started Using Skype



Your new Skype contact has been added and now will show up in your contact list as
grayed out until the user approves your request for authorization.Your new contact will see
the following screen to authorize you:

Once the contact approves you, the icon next to the user will turn green, showing you
that you have been approved and added to the other user’s contact list.

Go ahead and repeat the steps we just described to add to your contact list all the
people for whom you know their Skype contact names.
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Understanding the Basics… Advertise Your Skype Name
You can add your Skype name to your e-mail signature so that anyone you
normally communicate with will see you have a Skype name and can add
you to their contact lists:

Skype = mgough

Searching for Contacts
If you do not know your contact’s Skype name, you can search the Skype directory for con-
tacts using a simple search or and advanced search. Searches rely on the information a user
adds to his or her profile. If your contact does not fill in all the profile entries, you will have
difficulty locating that person.

Basic Search
There are two ways to start a basic search. One is by selecting the icon; the other is
from the Tools menu.

Select one of the two options to add a user, and you will be presented with the fol-
lowing screen:
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Type the term you want to search for into the Search text box.You can search for three
information items in the main Search box:

■ User’s Skype name

■ User’s full name

■ User’s e-mail address

Fill in what you want to search for and select the button, and your results
will be returned. In the following screen I searched for SkypeTips, to return my username.

Advanced Search
If the basic search does not locate the user you are looking for, you can use additional infor-
mation items to search for a user:

■ State

■ City

■ Language

■ Gender

■ Age range

Do not worry about SkypeMe mode at this time; we’ll cover that a little later.
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You can now search for a contact by any of the criteria shown on this screen. Keep in
mind that you can only search for information the user has entered into his or her profile. If
the user did not input a city, for example, you will not be able to locate him or her based
on city.

You may also use the wildcard ( * ) option to search for all items.The wildcard option
will return some interesting results. In the following screen, I typed in M* Gough.This
returns the names of anyone whose first name starts with M and whose last name or Skype
name is Gough.

Use the various search options and the wildcard to find the Skype users you are looking
to add to your contact list.
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Starting a Chat
One of Skype’s main features that you will use often is the Chat or IM feature.You will just
say “Hi” or ask if someone is available for a voice call using the Chat option.

Before we start to explain how to start a Chat, we first need to discuss the selection of a
contact in your list. Until now your contact list looked something like this.

When you select a contact in your list, the view will change to expand that user’s 
information.
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The Contact name expands to include some basic profile information about the user.At
this point, you can also right-click on the user name to get a menu of actions.

To start a chat, find the contact you want, select the name with a single mouse click,
and initiate the chat using one of two methods: Select the icon at the top of the screen

or right-click with your mouse on the contact name, and select . We
will discuss how to adjust the Skype Options settings later in this chapter, but if you make
the default for double-click a contact to Start Chat, you will also be able to initiate a chat
by double-clicking your contact’s name. Most IM tools such as MSN,Yahoo!,AIM, and
others all use double-clicking to start a chat, so you will want to change this so that when
you double-click a contact in your list it opens a Chat window and does not call your
contact.

Once the Chat window is open, you can start typing your message, use emoticons,
change the text, and invite other contacts to your chat.

Notice the icon in the bottom-right corner.This lock icon indicates that the chat
session between contacts is encrypted with 256-bit AES encryption.

From within the Chat window you can also initiate the following actions by clicking
these icons:

■ Add a contact to your chat (multiparty chat) 

■ Set the topic of your chat 

■ Quit the current chat 
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■ Call your contact 

■ Send your contact a file

You can also view a contact’s profile by selecting the profile icon from the side of
the Chat window.

Making a Test Call
Now that Skype is installed and you have added one or more contacts, it is time to make
your first test call. Skype provides a test user called Echo123 that is added when Skype is
installed.

Select the Echo123 contact and you will see the following screen:

You can double-click the contact name to call, select the icon to call Echo123, or
right-click the contact name and select . Call Echo123 and you will
be greeted with a message to start talking after the message, just like an answering machine.
Once you complete your 10-second message, it will be played back to you so that you’ll
know whether Skype is working properly. If you hear your message played back, you are
good to go!

You are now ready to make your first Skype voice call to a real contact!
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Making Your First Call
Now that you have completed the system test, you are ready to start talking with your
family, friends, and colleagues.

Select a contact and either double-click the contact’s name or use the icon to
initiate the call. When you call someone and that person does not answer, you will get a
busy signal or voicemail. Once a contact answers, you can do the following within a call:

■ Chat

■ Call another contact or make a conference call

■ Send your contact a file

■ View their profile

■ Put the call on hold

■ Mute or unmute the microphone

When you initiate a call to one of your contacts and they answer, you will see a screen
that resembles the following:
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Expand the Skype window by selecting the right side of the window and dragging the
window wider to the right to expose two additional icons.You should see the following
screen.

Notice that you now have two more icons for putting the call on hold and muting 
the call.

In the bottom left corner of the screen, you should see the icon.This lock indicates
that the voice call session between contacts is encrypted with 256bit AES encryption.
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Putting a Call on Hold
You can place the call on hold so that you can answer another call or attend to a task by
selecting the icon.You might want to do this to answer another call or to initiate a con-
ference call, or for any other reason.To take the call off hold, select the icon.

Muting and Unmuting the Microphone
You can mute and unmute the microphone by selecting the icon.You might want to do
this to reduce feedback if you are using a microphone and external speakers, if you are just
listening to a conference call, or if someone is talking to you in person and you do not want
your call participants to hear what is going on.To unmute the microphone, select the 
icon again.

Hanging Up the Call
Either party can end the call by selecting the hangup icon.

Inviting Others to Join Skype
Since not everyone you know has or uses Skype, you might want to invite your family,
friends, and colleagues to learn and use this great tool. Of course, you can ask them verbally
or send them an e-mail, but Skype offers an automated way that will also provide the
invitee a link via which he or she can download Skype.To do this, select Share Skype
with a Friend from the Tools menu.
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This choice launches your browser and takes you to the Skype Web site, where you can
invite users to download and start using Skype via an e-mail Skype sends.

You can also send your family, friends, and colleagues an e-mail that contains a URL to
the Skype download page, but the Skype invitation page makes it easy for you to invite
users and get them familiar with the Skype Web site.

Setting Your Status
To let others online know your status (whether you’re online or off ), use the Current Status
setting.You set your status by selecting the drop-down box indicated by the icon in
the bottom-left corner of the Skype screen.
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You can also set your status from the Task Bar icon in the bottom-right corner of
your screen.

You are presented with seven status options:

■ Offline

■ Online

■ Skype Me

■ Away

■ Not Available

■ Do Not Disturb

■ Invisible

Offline
The Offline status setting will make you appear to your contacts as though you are not
online.They can, however, send you chat messages and call you.

■ Indicates that you are offline (even if you’re not)

■ Contacts see you as offline

■ You can be contacted via chat and calls
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Online
The Online status setting changes your status back to normal online status and available for
all features.

■ Indicates that you are available and online

■ Contacts can see that you are online

■ You can be contacted via chat and calls

Skype Me
The Skype Me status setting makes you available for random chat, and anyone can call or
chat with you without authorization.This setting overrides the authorization requests, so make
sure that you really want this status setting because it means that anyone at any time can
contact you from searches in the Skype directory. Privacy is basically disabled while this
status setting is selected.

■ Indicates that you are available and taking any calls from anyone, without autho-
rization

■ Contacts can see you are online and you can be “Skyped”

■ You can be contacted via chat and calls

Understanding the Basics… Skype Me Status
Be careful using the Skype Me status option because it means that anyone
can contact you any time, without authorization.

Away
The Away status setting tells your contacts that you are “away” and not at your computer to
answer calls or chat.All features still work with this status setting enabled.This setting can be
set manually and is automatically set to Away after you have not used your computer for a
short period of time—five minutes by default.The status setting will return to Online once
computer activity is sensed, only when it was automatically set by inactivity.

■ Indicates that you are away from your computer for a short period of time

■ Contacts can see you are online but away
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■ Automatically changes back to Online when computer activity is sensed

■ You can be contacted via chat and calls

Not Available
The Not Available status setting tells your contacts you unavailable and not at your com-
puter to answer calls or chat.All features still work with this status setting enabled.This set-
ting can be set manually and is automatically set to Not Available after you have not used
your computer for a long period of time—20 minutes by default.The status setting will
return to Online once computer activity is sensed, only when it was automatically set by
inactivity.

■ Indicates that you have been away for a long period of time

■ Contacts can see that you are online but are not available

■ Automatically changes back to Online when computer activity is sensed

■ You can be contacted via chat and calls

Do Not Disturb
The Do Not Disturb status setting tells your contacts that you cannot be disturbed.Your
contacts cannot contact you, and chats and calls will not come through.You must change
this status setting when you want your contacts to know that you are available again.

■ Contacts can see that you are online but status is Do Not Disturb

■ You can make outbound contacts

■ You cannot be contacted 

Invisible
The Invisible status setting makes it look as though you are offline.You can still be con-
tacted when the status is set to Invisible.

■ Contacts see you as offline

■ You cannot make outbound chats or calls

■ You can be contacted 
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Basic Options
Now that you are up and running with Skype, we can explore the options available to
better configure and customize Skype to your personal preferences.The following are the
options that you can configure to meet your needs:

■ General settings

■ Privacy

■ Notifications

■ Sound alerts

■ Sound devices (advanced)

■ Hotkeys

■ Connection (advanced)

■ Advanced

■ Voicemail (advanced)

We will not cover all these settings in this chapter, since we are only covering the basic
settings at this point.The advanced settings are covered later in the book.To access the
Skype Options settings, select the Tools menu, then select Options.
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You will be presented with the list of options in the General Options tab.

Save and Cancel Buttons
If you change a setting, you must do one of two things: Click the button to save
your changes, or click the button to cancel your changes.You should do this at each
of the Option tabs to save or cancel your settings. Some changes require you to restart
Skype, so just follow the prompts.

General Options
The General options tab allows you to set the following items:

■ Double-click on a contact or use the address field

■ Show emoticons

■ Show me as away after X minutes

■ Show me as not available after X minutes

Under Related Tasks, you will see:

■ Edit your profile

■ Adjust your sound devices

■ Set connection parameters and proxy
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When I Double-Click a 
Contact Name, What Happens?
By default, when you double-click your mouse a contact name, Skype calls that contact.You
might find that this is not the best option, because every time you double-click a user name
accidentally, you will call that contact and then have to cancel the call. We recommend you
change this setting to Start Chat.Then you can call your contact from within the Chat
window by selecting the icon, as we discussed in Chapter 2.

If you are an MSN,Yahoo!,AIM, or other IM user, you might find it convenient to set
Start Chat as your default.

Understanding the Basics… General Options
We recommend that you set the Double-Click option to:
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Show Emoticons
Emoticons are the cute little animated icons that appear in your Chat window when you
select one of them from the menu.They help convey your feelings in an instant message.
You will want to enable this setting unless you do not prefer to use emoticons.

Understanding the Basics… General Options
We recommend you set the Emoticons option to:

Show Me As…
There are two status settings that are automatic when you stop using your computer for a
period of time. Skype will automatically set your status to one of the following:
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We covered what these two settings mean in Chapter 2. If you want to adjust these set-
tings so other users do not think you are away or not available after the default period of
time, you may set these to your desired state. If you set the Away value to 0 it will disable
both these features.

Understanding the Basics… General Options
We recommend you set the Show me as option to:

Related Tasks: Editing Your Skype Profile
Skype lists several items that are related in the Related Tasks area. For the General tab, the
following are listed.

We cover only editing your profile here, since Adjust sound devices and Set connection
parameters and proxies are advanced settings we cover in the “Advanced Settings” section of
Chapter 6.

The one related task that appears in the General tab is the settings.This
is where you add more information about yourself that you want published in the Skype
directory.The information you enter here is public information, so take care not to enter
information you do not want others to know about you.
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When you select the option, you will be presented with the following
screen:

As you can see by my profile, I choose to share very little information with the public. I
prefer that people contact me through my Web site or send me e-mail.This way I can limit
the number of people looking for other Michael Goughs in the world or people who think
they know me but whom I don’t remember.

What you put in here will be your personal preference.You can use the Full Name field
to list something additional about you. Notice in the following screen that I have modified
my Full Name to include my SkypeTips.com Web site.You need to close Skype and log on
again for this information to be made available, or you can wait until the next time you
restart your computer.
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This is what your contacts will see when they select your name (Chapter 6 explains in
detail how to use the fields in this dialog box):

This way you can customize what your contacts see next to your name on their contact
list, or in my case my SkypeTips.com Web site.

Privacy Options
The Privacy Options tab allows you to set the following items:

■ Allow calls from

■ Allow chat from

■ Allow SkypeIn calls from (advanced)

■ Keep Chat History

Under Related Tasks, you will see:

■ Manage blocked users

■ Manage other programs’ access to Skype (advanced)
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If people do a search and find you in the Skype directory, these settings will control what
they can do upon selecting you as a new contact.The following is a list of possible settings:

■ Anyone can call or chat

■ Only people from my contacts list can call or chat

■ Only people whom I have authorized can call or chat

It is important that you understand the differences among these three settings so that
you make the best choice for your situation.The three settings have different meanings in
terms of the way people can chat and call you. Do you want anyone to initiate a chat or call
you before or after authorization, or do you want only people in your contacts list to be
able to chat or call you?

Anyone Can …
If this option is selected, anyone can send a chat message or call you after they send you a
request for Authorization. However, also be aware that they can chat and call you before you
authorize them, as a part of asking you for authorization. Others can use this setting to
explain to you who they are and why you should authorize them.

Only People from My Contacts Can …
If this option is selected, only people you have added to your contacts can send a chat mes-
sage or call you. Users will be alerted that you are “not a contact” in their main Skype
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window if they attempt to chat or call you.They must of course be authorized first or you
must have requested authorization from them. If you are privacy conscious and do not want
to be contacted by a user until you add that user to your contact list, this is the best setting
to choose.Also, if you once authorized a contact and later removed the person from your
contacts list, that user will be unable to chat to or call you. When a contact sends you a
request for authorization, the chat and call features will be disabled.

Only People Whom I Have Authorized Can …
If this option is selected, potential contacts cannot chat or call you until after you have
authorized them and added them to your contacts. Users will be alerted that they are “not
authorized to call” you in their main Skype window if they attempt to chat to or call you.
If you delete a contact from your contact list with this option set, the user may still chat to
or call you.

Understanding the Basics… Privacy Options
Here’s a brief summary of the privacy options:

■ For the most privacy, enable Only people from my Contacts can…
■ For good privacy, enable Only people whom I have authorized

can…
■ For the least privacy, enable Anyone can…

Allow Calls From
This setting is where you set who can call you.

Understanding the Basics… Privacy Options
We recommend you set the Allow Calls option to:
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Allow Chat From
This is where you set who can chat with you.

Understanding the Basics… Privacy Options
We recommend you set the Allow Chats option to:

Keep Chat History
If you chat with your contacts, you might close the chat window and later want to
remember what you chatted about. Skype gives you the option of saving your history for
each chat for the following lengths of time:

■ No history

■ Two weeks

■ One month

■ Three months

■ Forever

You may select whatever option you feel is best, but we would recommend changing
this setting only after you understand Skype better and when you know that you do not
want to save the chat history forever. Chat histories are stored unencrypted on users’
machines.

Understanding the Basics… Privacy Options
We recommend you set the Keep chat history for option to Forever.
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Related Tasks
In the Related Tasks area, Skype lists several items that are related. For the Privacy tab, the
following items are listed.

We cover only Manage blocked users here. Manage other programs’ access to Skype is an
advanced setting that we cover in the “Advanced Settings” section of Chapter 6.

Blocked Users
To access and manage your list of blocked users, use the Related Tasks area of the 
Privacy tab.

If there is a person or people you do not want to contact you or that have harassed you
via a crank call, for example, you can block them by adding them to your Blocked Users
list.This tab is where you manage the list.
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You may also initially block a user when you right-click his or her name in your con-
tacts list.You can also access this list from within a chat window by selecting the icon.

Notification Options
The Notification options tab allows you to display a notification if another Skype user does
one of the following:

■ Comes online

■ Calls you

■ Starts a chat with you

■ Sends you a file

■ Requests authorization

■ Sends you contacts

■ Leaves you a voicemail (advanced)

■ Displays messages for Help/Tips
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Only the Comes online setting is annoying when it’s set.As users come and go, the noti-
fication pops up in the bottom-right corner of your screen and can be very active, since it
will also notify you regarding users’ status change from Away, Not Available, and others. We
recommend leaving the other settings on by default so you know when an event happens.

Understanding the Basics… Privacy Options
We recommend you set the Comes online option to:

Related Tasks
In the Related Tasks area, Skype lists several items that are related. For the Notification tab,
the following are listed:

Configure sound alerts is an advanced setting that we cover in the “Advanced Settings”
section of Chapter 6.
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Tasks Bar Icon
When an event has happened that you missed, the icon in the Windows Task Bar will
flash with a caution icon like this .This notifies you that you have a missed call.

Events
Skype notifies you of any events in the main Skype window, such as missed calls or if
someone has left you voicemail message.

Within your main Skype window, you will see a message in the Event window:

This message will tell you how many events you have.To check an event, simply select
the yellow tab and it will expand to show you the specific events from each user.



You’ll see if you have a missed call or someone has left you voicemail (more on that in
the “Voice Mail” section of Chapter 6). When you select the specific event, it will take you
to all the events related to that contact.

Here you can listen to your voicemail or delete the event by selecting the trash 
icon.

Sound Alerts
The Sound Alerts option allows you to set the sounds that play for certain events. Next to
each option are three icons:

■ Play the sound

■ Select a different sound file

■ Reset the sound to Skype default
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The default sounds are a good place to start, but if you tend to change sounds to your
liking, feel free to customize Skype to play sounds the way you want.

Understanding the Basics… Privacy Options
We recommend you deselect the Play sound when contacts come
online setting:

You may also choose Mute All Sounds and rely solely on the visual alerts to let you
know what Skype is doing. We do not recommend this choice, however, as you could just
as easily mute your sound card or turn off your speakers if you do not want Skype to make
sounds as you use it.

Hotkeys Options
Many users still like to use the keyboard to control certain functions of their computer.
Skype allows you to set several hotkeys for the following actions:

■ Answer call

■ Ignore call
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■ Reject/hang up call

■ Focus Skype

■ Search for Skype users

■ Mute microphone

If you want to use hotkeys, you first have to enable them by selecting the Enable
global hotkeys check box.

After you enable the hotkeys, you can set or change them to what you want. First, set
the hotkey combination you want. Select the button and you will be
prompted with the following screen:
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Fill in the hotkey combination you want to use. In the following example, we will set
Focus Skype to Alt + S.

Now when you press the Alt + S key combination, the main Skype window will
appear.

Now you must select the button to activate your setting.

Understanding the Basics… Hotkeys
Be sure to test your hotkey combination to see whether any of the applica-
tions you normally use have the same combination you want to set for Skype.

40 Chapter 3 • Getting Started Using Skype



While in Chat, Pressing Enter Will …
When you use chat, the default action when you press Enter is to send the chat message to
your contact. If you like, you can change this action so that when you press Enter, you only
create a new line in your message instead of sending the message. If you do this, you will
have to use your mouse to send the message by selecting the Enter icon in the chat
window.

Understanding the Basics… 
While in Chat, Pressing Enter Will…
We recommend leaving the default to Enter sending the chat message:
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A Word about Network Address
Translation and Firewalls
When the Internet began, the creators didn’t envision the type of growth that we are expe-
riencing today. During the last 10 years, the number of hosts on the Internet increased by
more than 50 times.1 In order for each Internet device, or host, to communicate on the
Internet, it must have a unique internet protocol (IP) address.The addressing scheme for the
Internet allowed for billions of IP addresses, but now most of them are allocated.

The Internet’s popularity results in a maximum number of available IP addresses.
Homes and offices around the world are now connecting many hosts at a single location
and it is not possible for every single device to have its own public IP address.To accommo-
date the limited amount of addresses, a new standard called IPv6 has been developed. Until
IPv6 is finalized, other methods are needed to allow for allocation of public addresses to
more people.The most effective solution is called network address translation (NAT),
defined in the request for comments 1631 (RFC 1631).

NAT is a special type of router that has several different implementations. One popular
method of implementation allows for the use of special, unroutable IP addresses on private
or internal networks.The private addresses are translated to a public host address, which
allows communication over the Internet.Three blocks of the unroutable, or private, IP
addresses are defined in RFC 1597 and RFC 1918.The private addresses are reserved by
the Internet Assigned Numbers Authority (IANA), the organization that is responsible for
all IP addresses.The private addresses are represented in Classless Inter-Domain Routing
(CIDR) notation as:

■ 10.0.0.0/8

■ 172.16.0.0/12

■ 192.168.0.0/16
These address blocks cannot communicate directly with public addresses on the

Internet and must be translated.
NAT utilizes a mechanism in the Transmission Control Protocol/Internet Protocol

(TCP/IP) stack called multiplexing to enable these private addresses to establish communi-
cation over the Internet. Multiplexing makes it possible for a single device to establish and
maintain several simultaneous connections with one or more hosts using different TCP and
User Datagram Protocol (UDP) ports.This architecture allows an implementation where a
single public IP address can service the needs of an entire network of hosts, a many—to-one
relationship.
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NAT routers keep a table of internal address and port combinations, as well as the
public (global) IP address and port used to establish the remote connection. External hosts
do not see the internal address, but instead use the public IP address to respond to requests.
When responses are sent back to the external IP address and port of the NAT router, it
translates the response and relays it back to the internal address and port that originated the
request.

Firewalls are Protocol layer rules engines.A firewall can be hardware or software based,
and many routers include basic firewall functionality as an additional feature.A typical fire-
wall provides a list of rules that are evaluated sequentially against the header data in the
packet being processed.As each rule is examined against the packet header, the packet will
be blocked, or the next rule will be evaluated.This process continues until the packet is
blocked or all rules have been examined.

A proxy server is similar to a firewall, but it works at the Application layer. Proxy servers
have packet-filtering features. Packet filtering allows examination of the actual data being
transmitted within the packet itself. Packet filters are available on Windows XP, Windows
2000, and Windows Server 2003 products as part of the advanced features of the TCP/IP
configuration. However, because Skype encrypts the data it transmits, packet filtering is an
ineffective means of managing Skype traffic. Proxy servers handle the requests for each pro-
tocol, whereas firewalls merely forward the traffic. If the proxy server is disabled, no traffic is
allowed to pass. If you disable a firewall, you are turning off all rules processing and allowing
all traffic to pass, which is not a recommended practice.
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In the preceding diagram, a single external IP address is exposed to the Internet. When
hosts on the private network make a request, the following occurs:

1. The host initiates a request for the remote destination address and port.

2. Since the address is remote, the router handles the request.

3. The NAT router adds the entry for the internal host IP address and port to the
translation table.

4. The NAT router assigns a new port on the external interface IP address for the
internal client and adds it to the translation table.

5. The NAT router then initiates a connection to the remote host on the external
network, through the firewall, substituting a new source port and IP address in the
IP packet header.

6. The remote host responds to the request to the external address and port.

7. The firewall compares the IP address and port with the list of firewall rules. If the
IP address passes the IP address test, the port is checked. For Skype, this would be
a UDP port, or if UDP is blocked,TCP port 443 or TCP port 80.

8. The router uses the translation table to translate the response from the remote host
from the external address and port to the original internal address and port of the
host that initiated the request.

Home Users
We strongly recommended that home users obtain a basic peer-to-peer-friendly, broadband
router with firewall capabilities. In addition to a hardware-based router/firewall, you should
always use a software-based firewall on each client machine. Windows XP has built-in fire-
wall software that is enabled by default after you install Service Pack 2. Other options for
software-based firewalls include products by McAfee, Symantec, and Zone Alarm. Skype
should work right out of the gate on most home networks without requiring any further
configuration. For home users, no modification is needed.

Later in this chapter, we discuss how to improve the quality of the communication,
which could require minor configuration settings on your firewall.

Small to Medium-Sized Businesses
Small to medium-sized businesses must use discretion to determine whether to use a simple
implementation, as discussed for home users, or to provide a more robust firewall solution,
such as the Symantec Firewall/VPN Appliance, Cisco Pix, or other SOHO solution.
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Regardless, we suggest that small and medium-sized businesses use software-based firewalls
on each network client to provide an additional layer of security.

Large Corporations
Larger corporations must ensure that the many routers used on the LAN allow Skype traffic
over UDP to pass to other clients on the LAN if they want to use Skype effectively.

To better understand how Skype communicates, you need to get a picture of how the
Skype network is organized.There are three basic roles in the Skype communication infras-
tructure.The roles consist of the following:

■ Skype client or peer

■ Supernodes

■ Login servers
A Skype client is your computer running the Skype software. Supernodes are just Skype

peer nodes that are not behind a firewall or have unrestricted access to the Internet.
Supernodes come and go depending on the needs of the overall network.Any Skype client
node can become a supernode if it is not behind a NAT router or blocking firewall and has
sufficient CPU and bandwidth capacity.

Understanding the Basics… Avoid Becoming a Supernode
To avoid a Skype client from becoming a supernode all that is required is for
the client to be behind a NAT device or a corporate firewall device.

If a Skype client is behind a NAT router or firewall, the Skype client cannot establish a
direct connection to another peer. In these situations, the supernode peers act as relaying
agents to help Skype peers behind firewalls or NAT routers establish connections to other
peers that are behind firewalls or NAT routers. Skype peers tend to connect to supernodes
that are in relative proximity to their locations on the Internet. By connecting to nearby
supernodes, Skype reduces utilization and decreases the latency in response times, thus pro-
viding a fast and scalable communication network.

Understanding the Basics… 
Avoid Relayed Calls or File Transfers
To avoid a Skype call or file transfer from being relayed, the firewall must
allow a P2P connection.
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When Skype starts, it determines whether the client is behind a firewall or NAT router.
If there is a firewall or NAT router, Skype determines the best method for communication
via the firewall or NAT router using various UDP mechanisms. If no UDP ports are open,
Skype will attempt to use TCP port 80, then TCP Port 443. Refer to the basic topology to
get a picture of what happens next.

After Skype Client A determines how to navigate the firewall or NAT router, Skype
contacts a supernode peer from its supernode list to attempt to log in. If for some reason
there are no supernodes listed for the client, the client attempts to log in to the Skype
login server. Once the client logs in, the supernode list may be updated with the current
active list of supernodes.

Once the connection is established, you can place a call, begin to instant message, or
transfer a file.The call starts with a search of the Skype Global Index to locate the target
Skype user. Skype Client B will follow the same process to log in. If the target user, Skype
Client B, is behind a firewall or non-P2P-friendly device, the supernode acts as the liaison
to direct TCP traffic from client A to Client B and vice versa, thus allowing Skype Clients A
and B to find and communicate with each other using one or more supernode peers to
relay messages.

What You Need to Know about
Configuring Your Network Devices
We’ll now discuss configuring network devices in various environments.
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Home Users or Businesses Using 
a DSL/Cable Router And No Firewall
To use Skype typical home users will not need to configure anything on their DSL/Cable
routers with or without wireless unless they have an older DSL/Cable router that is not
P2P friendly. Running NAT Check, discussed later in this chapter, and enabling the
Technical Information in Skype’s Advanced options will help you determine if your router
is capable of a Skype P2P connection.

Small to Large Company Firewall Users
To provide the best performance on your network, you will need to tune your network to
optimize handling of the Skype traffic. Skype leverages the use of UDP extensively to pro-
vide the best possible connection quality with its peers.The NAT translation table is a
volatile table that ages old connections to free up room in the routing device’s buffer for
new connections.

It is important that the NAT routers hold the definition for UDP datagrams sent from
the internal network for at least 30 seconds.The delay ensures that there is ample time pro-
vided for a response to the original request initiated from the client.The translation table
should consistently map the internal host address and port number for UDP traffic in order
to be reliably translated from the external address and port used to establish the communi-
cation. UDP has very little overhead, but it is prone to loss because it is not guaranteed to
be delivered to the destination. Because it has little overhead, UDP is a faster method for
communications.

TCP and UDP Primer
TCP requires a threeway handshake to verify that data reaches its destination, whereas UDP
just sends that data and does not require acknowledgment of delivery. Because UDP does
not require all of the overhead in the message structure, the messages are smaller, and UDP
headers are always the same size.The UDP message structure makes the delivery much
faster. Establishing communication sessions over TCP takes three trips instead of the one trip
UDP requires.The TCP headers are much larger and vary in size, so there is more overhead
to process each TCP message as well.
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NAT vs. a Firewall
Remember, a NAT device just translates many internal IP addresses to one or more external
routable Internet addresses.A firewall can also provide NAT functionality and includes addi-
tional intelligence to apply rules to the traffic that passes through the firewall. NAT devices
such as a DSL/cable router may or may not have firewall functionality.

Skype also recommends that the firewall or Internet gateway support IP packet frag-
mentation and reassembly. Fragmenting the packets allows the stream of data to be broken
into smaller packets that can be sent simultaneously over multiple ports to the destination.
This packet fragmentation can dramatically improve quality and performance by allowing
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higher throughput, which in turn allows for more effective bandwidth. Some firewalls
detect this type of parallel UDP communication incorrectly as port scanning and will block
the host traffic.The result could be a degradation of Skype performance.

Skype references a tool called NAT Check by Bryan Ford.The tool can be located at
http://midcom-p2p.sourceforge.net.

The tool can be used to determine how P2P friendly your network is. Ford has
described the details on UDP communications over the Internet using NAT in an Internet
draft.The paper is located at http://mirrors.isc.org/pub/www.watersprings.org/
pub/id/draft-ford-natp2p-00.txt.

The following example shows the output from NAT Check for a relayed call:

Ports Required for Skype
We’ll now discuss the ports that are required to use Skype.

Home Users or Businesses 
Using a DSL/Cable Router and No Firewall
To use Skype, typical home users will not need to configure anything on their DSL/cable
routers or within the Skype software.
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Small to Large Company Firewall Users
Skype uses UDP and TCP to communicate with other Skype clients. UDP is primarily
used to establish connectivity and perform global directory searches. If the UDP ports above
1024 are open outbound, and you allow UDP replies to return through the firewall, you
can improve Skype’s voice quality and performance. Opening UDP ports could allow peers
on your network to connect more efficiently by providing closer neighbors on the P2P net-
work, thus reducing latency and improving call quality.Allowing more UDP ports also pre-
vents internal contention of port translation in the NAT translation table.

In a perfect world, all outgoing TCP ports would be open through the firewall or
Internet gateway. If it is not possible to open all outgoing ports,TCP port 80 should be
opened. Using port 80 is a standard practice. When Skype attempts to log on, it first tries to
connect using random ports. If Skype cannot connect, it attempts to connect via port 80. If
port 80 cannot be opened, Skype attempts to use port 443.There is no guarantee that
Skype will work through port 80 if the firewall or proxy server is restricting traffic to the
HTTP. By restricting traffic to HTTP, the proxy server or firewall can scan the packets to
ensure that the data is actually HTTP data. Skype does not use HTTP and will not function
correctly through port 80 if traffic is restricted to HTTP traffic. If you receive errors #1101,
#1102, or #1103 the firewall may be blocking port 80.

When Skype installs, it will select a random UDP port to communicate.This port set-
ting is found in the Connection tab under Options and is an adjustable setting and stored in
the shared.xml file on each computer and could be set the same for all users of Skype. If
you want to avoid relayed Skype calls and relayed file transfers, you can open up the UDP
port on your firewall that is specified in Skype to allow for better voice call quality and
faster file transfers.

Understand that opening these UDP ports changes the normal corporate security
policy, and proper approval and risks associated with opening anything on your firewall
should be weighed prior to opening these settings. Discuss this issue thoroughly with your
information security team on the impacts and what additional layers of security could be
implemented to mitigate any risks, such as enabling a client-side personal firewall solution
discussed earlier in this chapter.You could allow TCP and/or UDP inbound on the ports
listed in Skype options for all clients internal to the firewall. If necessary, Skype will use
TCP ports 80 and 443, respectively, to communicate with other Skype peers, and this will
create relayed Skype calls and slow file transfers..
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Skype’s Shared.xml file
In a larger network, you can control the port for incoming connections by modifying
Skype’s shared.xml file in the following location:

■ <Drive>\Documents and Settings\<UserName>\Application Data\Skype folder

The setting is found toward the end of the file under config/Lib/Connection/
ListeningPort. By configuring all users to use the same UDP port, you can improve the
quality of Skype conversations by opening a single inbound UDP port, if your network
security policy permits this. If the traffic inbound on that port is high, you could logically
segment the traffic by setting different groups of users to use a specific UDP port and
opening multiple UDP ports inbound, while still maintaining some control over what ports
are opened and to whom. Visit Dan Douglass’s Web site at the following URL for scripts
and utilities to help modify the shared.xml setting in a business environment: www.code-
hatchery.com/skype.html.

Microsoft Windows Active Directory
In a typical Windows Active Directory-based enterprise, with clients running Windows XP
Service Pack 2, you can set a Group Policy that allows you to enable the Skype traffic
through the Windows Firewall on all client machines with little effort.This can be achieved
via the following steps:

Skype Firewall and Network Setup • Chapter 13 53



1. Open the Group Policy Object Editor console on the Active Directory
Domain controller.

2. Locate the Group Policy setting found in Computer
Configuration\Administrative Templates\Network\Network
Connections\Windows Firewall\Standard Profile.

3. Select the Policy Setting for Windows Firewall to enable the Define program
exceptions policy.
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4. Next, click the Show Button that was enabled by the previous step.

5. Add a definition for a Program Exception as %PROGRAMFILES%\skype\
phone\skype.exe:*:enabled:Skype and then click OK.

6. Click OK to close the Show Contents dialog box, then click the OK button to
close the Windows Firewall: Define program exceptions Properties dialog box.

7. Allow time for the Group Policy to be refreshed.The time varies depending on
the network settings.Allowing exceptions for Skype and opening up the recom-
mended ports make it easier for Skype to establish reliable communications out-
side of your network. Other products, such as Norton Internet Security, McAfee
Firewall Pro, and Zone Alarm Pro, have similar functionality. Visit Skype’s Web site
at http://web.skype.com/help_firewalls.html for the specific configuration of your
product.

The same option can also be manually configured on each workstation in the enterprise
by using the Windows Firewall applet in Control Panel.
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1. Open Control Panel and double-click the Windows Firewall icon.

2. Click the Exceptions tab.

3. Tick the box next to Skype.

Using Proxy Servers and Skype
Many popular proxy servers are available on the market today. Skype supports HTTPS, SSL,
and SOCKS5 proxy standards. Skype can optionally include authentication over proxies if
the proxy server requires it. On Windows clients, Skype automatically uses the connection
settings in Internet Explorer to identify the proxy settings that may be defined for that user
on that computer. It is possible for the user to set Skype to use a manual configuration in
the Tools menu, Options, and Connection tab settings.

If you are using a SOCKS5 proxy server, it must allow unrestricted connections to the
ports discussed in the ‘”Ports Required for Skype” section of this chapter. Most proxy server
solutions provide packet-filtering features.As previously mentioned, enabling packet filtering
and restricting traffic over port 80 to only HTTP  could cause communication problems for
Skype.

Many companies implement a wireless network, preferably using 802.11G, that directly
connects to the Internet. If you want to then connect to company resources, you would
VPN back into the corporate network just as you would from home or a hotel over the
wireless network.The wireless network could allow for fewer restrictions on traffic for wire-
less clients while still allowing for stricter security on the wired devices. Refer to Chapters 2
and 10 for more information on wireless communication with Skype.You should also read
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the papers on wireless infrastructures at http://cisecurity.org/bench_wireless.html for more
information on implementing wireless in your enterprise.

If you are experiencing , high latency or poor voice quality with Skype, you can trou-
bleshoot your connection quality by using NAT Check  or Skype’s Display Technical Call
info feature found in the Advanced options tab.To enable the tech support feature or edit
the Config.xml file manually:

1. Exit Skype.

2. Locate the Config.xml file located in the <Drive>\Documents and
Settings\<User Name>\Application Data\Skype\<Skype user name>
folder and open it with Notepad.exe or a similar text editor.

3. Find the setting config/UI/Messages/DisplayCallInfo

4. Change the value from 0 to 1 and save the file.

5. Launch Skype.
Visit Dan Douglass’s Web site at the following URL for scripts and utilities to modify

the config.xml file setting in a business environment: www.codehatchery.com/skype.html.
Once you have enabled the Display Technical call info feature, you can make a test

call to the Skype Test Call user. Once you have established the call, simply hover the mouse
cursor over the user’s avatar (picture), and you will see a tooltip-style popup with connec-
tion information:

Note that in this scenario, the relays count is 0 and the roundtrip time is 105ms
(1000ms = 1 second). Since the Skype answering machine is open, the connection is very
clean, and there is very little latency.
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Display Technical Call Information
The following is detailed information about the Technical Call Information popup items
shown in the preceding and following examples.An overview of this information is pro-
vided in the section titled “Using Skype’s Technical Call Information” in Chapter 6.

Call Status

■ 0 = Hosting conference.

■ 1 = ROUTING - call is currently being routed.

■ ??  EARLYMEDIA - with the pstn there is possibility that before the call is actu-
ally established, the early media is being played. For example, it can be a calling
tone, or it can be some waiting message (all operators are busy, hold on for a sec)
etc.

■ ??  FAILED - call failed.Try to get FAILUREREASON for more information.

■ 3 = RINGING - currently ringing.

■ 4 =  INPROGRESS - call is in progress.

■ 5 = ONHOLD - call is placed on hold by you.

■ ?? FINISHED - call is finished.

■ ?? MISSED - call was missed.

■ 8 =  REFUSED - call was refused.

■ 8 =  BUSY - destination was busy i.e. pressed hang up button.

■ 10 = ONHOLD - call is placed on hold by other party.

■ 13 = CANCELED (Protocol 2)

■ ObjID: Ignore this information as it is not important.

■ Codec: ISAC is always the codec in use

■ Jitter: Network administrators need to look at jitter. Jitter is the variation in the
time between each of the delivered packets of data arriving from the source to the
destination.This could indicate a bandwidth bottleneck or heavy traffic from the
source to destination causing some packets to arrive sooner than others.The
common method for reducing jitter is to buffer data at the destination.

■ Packet Loss: Network administrators need to be aware of packet loss.This is the
total percentage of the packets of data that don’t make it to or from each party in
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the conversation.This should be low, but will be something if you are using UDP,
since delivery is not guaranteed.

■ Send packet loss: Network administrators should pay attention to this setting.This
indicates how much data is not making it to the destination party in the call. If the
Send packet loss is high, it means that something is causing the packets from get-
ting to the remote client.

■ Recv packet loss: Network administrators should pay attention to this setting.This
indicates how much data is not making it from the other party in the call. If the
Receive packet loss is high, it means that something is preventing the packets from
getting to you from the remote client.

■ Roundtrip: Normal users and Network administrators can get information from
this.The higher the number is, the longer it takes for your voice to get to the
other party and back.This should be low, and anything about 300ms starts to get
choppy, reducing call quality. Look at SessionOut and SessionIN, or run NAT
Check to determine why you are relaying.

■ BM:This is related to the bandwidth and quality of the audio and is not important.

■ SessionOut: Network administrators should look at this if roundrip values are
high.This should say UDP. If it says TCP or RELAY_UDP, then you are not
operating at the best performance. In this case look at UDP status remote. If it says
remote:Bad, then the remote party is behind a firewall and cannot receive UDP
traffic inbound from the supernode.

■ SessionIn Network Admins should look at this if roundrip values are high.This
should say UDP. If it says TCP or RELAY_UDP, you are not operating at the
best performance. In this case look at UDP status local. If it says local:Bad, you
could, at your discretion, open up the UDP port as discussed earlier in this chapter
to allow inbound UDP traffic through the firewall inbound from the supernode.

■ Relays:This is almost always 4, but 0 when you call Skype voice mail.

■ UDP status: should always be local:Good remote:Good. If either are Bad, look at
SessionIn/SessionOut to remedy.

■ CPU usage: 35.8% 13.4% Total CPU usage of each processor by all running appli-
cations on the local machine. If this is too high, then the machine may be too
overloaded to allow Skype to operate efficiently. Other applications will most
likely be suffering as well.
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The next example is a call to a user on large corporate network where no inbound UDP
is allowed back in through the firewall, and there is a very complex network infrastructure.

Note the difference in the SessionOut and SessionIn results. RELAY_UDP, and the
UDP status remote:Bad show us that the remote location is the problem and that the UDP
traffic is using a supernode to relay UDP information for each of the clients.The result of
the relays is the long roundtrip time of 629ms, and therefore, there is a delay in transmitting
the voice data to the remote client. Basically, it takes more than half a second for everything
you say to get to the remote client, so the conversation is choppy and degraded.To improve
this connection, the callers can use NAT Check to see if they are able to use UDP and
troubleshoot the connection. If it is possible to open the UDP port inbound to the remote
client in this scenario, the sessions can use a direct UDP or peer-to-peer connection, and
the communication will be improve almost tenfold. See the following example, to the same
caller, without the firewall restrictions:
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To summarize, if you have a bad connection, each client can run NAT Check and the
Display Technical info to see who is having difficulty communicating.The findings can be
confirmed with the configuration demonstrated in the previous section.To correct the issue,
determine the UDP port the trouble client is listening on. Open that port inbound by
defining a firewall rule.The rule should be specific to the client, so it might be something
like Allow:WAN * to LAN 192.169.1.21 UDP: 3259, which allows all WAN IP addresses
to communicate inbound to the private LAN address 192.168.1.21 over UDP port 3259.

Small to Large Companies
In most large companies, this will not be feasible and may possibly be against the corporate
security policy and allowable network practices, but this does remain an option for small to
medium-sized businesses that desire better communication quality and have the flexibility to
modify their firewall rules. Some firewalls allow rules to be enabled during a specific time
frame, and outside of that time window, the rule is disabled. If you are using Skype only
during business hours, this type of feature would provide better security than leaving the port
open all the time.With any modification to your firewall rules, be sure to check your corpo-
rate security policy and with corporate security and your network team to gain approval and
to understand the potential risks that are associated with opening any ports on a firewall to an
internal client.Additional layers of security should be implemented if this configuration is to
be used. If any peer-to-peer communication is allowed, it is recommended that the clients
have a personal firewall solution to further protect the systems from malicious activity.

How to Block Skype in the Enterprise
From a security or network administrator’s point of view, the very same features that make
Skype connect reliably through a restrictive firewall present a challenge to preventing or
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blocking Skype traffic on a network. Skype is very robust and can function with access to
only port 80. Most corporations allow outbound Web traffic, so port 80 (HTTP) must
remain open. Port 443 is the SSL port (HTTPS), and secure Web sites require this port to
remain open. It is not as simple as blocking ports to prevent Skype from functioning.

Several tasks must be completed to block Skype in your enterprise.The first step is to
block access to the Skype downloads to prevent the executable from even being installed on
your client machines.This practice is referred to as black listing.This step is not entirely
effective by itself, since some users might already have the Skype client installed or could
bring the installation package from home on a CD or thumb/flash drive.

It is good practice to prevent unnecessary applications from accessing the Internet.The
best way to achieve that is by blocking all ports on the firewall and then selectively allowing
known traffic to pass, the ”deny all unless explicitly allowed” mentality. In addition, you may
choose to restrict access to all Internet sites except those that have been approved by your
organization.This is referred to as white listing, and although it requires more maintenance, it
is much more secure.

Another method used to prevent communication over the Internet is to use packet fil-
ters. Packet filters examine the data inside the headers of transmitted packets.This informa-
tion can be used to create rules to dump messages that contain headers that meet the filter
criteria. Unfortunately, Skype data is encrypted, so packet filters are unable to examine the
information in the data packets; therefore, packet filtering is useless. However, a new hard-
ware device is purported to identify the signature of Skype communication and block
Skype traffic based on that identification.

In a corporate enterprise environment, you may have other software solutions that allow
the use of application filters on the desktops.This is another effective way to block Skype.The
method of policies depends on the platform, but essentially, the concept is the same.When a
user attempts to execute a program that is defined as disallowed, the process that monitors the
client will prevent the program from executing.An example of this would be to use Microsoft
Systems Management Server and define a restriction on the Skype.exe executable. Network
Associates and Symantec have similar features built in to their groupware products.

Skype is very effective at finding ways to communicate with other Skype peers.There is
no straightforward way to block Skype in the enterprise.The most effective method is to
prevent the program from running at all or scan for it on all systems that are not approved
and delete it from each system.

Endnote
1. “Number of Hosts Advertised in the DNS.” Internet Domain Survey, July 2005,
www.isc.org (accessed October 4, 2005)
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